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Chapitre 1
Introduction : synthèse de systèmes logiques en circuit

1 Les composants logiques recon�gurables en bref ...

Il s'agit de composants mettant à la disposition du concepteur un ensemble de portes aux interconnexions

recon�gurables et permettant la mise en oeuvre :

• de sommes de produits de termes (des fonctions ET de plusieurs entrées dont on réalise la somme avec

une fonction OU),

• de mémoires de base au niveau du bit, c'est à dire pour stocker un unique signal scalaire (bascules D,

RS, T, JK),

• de mémoires vectorielles (ROM, RAM, RAM double accès),

• de systèmes autorisant la gestion des horloges dans le circuit (PLL, réseau d'interconnexion dédié),

• de tout un ensemble de blocs d'entrées/sorties con�gurables pour s'adapter à l'environnement d'utili-

sation (signaux TTL, CMOS, LVTTL, LVCMOS, PCI ...).

2 Pourquoi utiliser des composants logiques recon�gurables ?

La création d'un nouveau circuit intégré assurant un ensemble de fonctions logiques est une opération

très coûteuse en temps et en moyens. On estime que le développement d'un ASIC 1 Full Custom (un circuit

intégré dont la structure est gravée et �gée) nécessite en moyenne 18 mois et que chaque remise en cause

du design (à cause de bug par exemple) peut entraîner un retard de l'ordre de 3 à 6 mois pour réaliser une

nouvelle puce testable.

De fait, ce type de développement était historiquement et reste encore aujourd'hui reservé à des projets

avec des objectifs de grandes séries.

Par ailleurs, la complexité des puces de fortes densités telles que des processeurs ont apporté leur lot de

contraintes supplémentaires. Le nombre d'éléments logiques impliqués dans de tels projets a eu rapidement

pour conséquence de rendre les simulations fonctionnelles extrêmement longues et di�ciles, même avec les

moyens informatiques d'aujourd'hui.

C'est pour ces deux types de production que des composants logiques programmables de fortes densités,

c'est à dire abritant plusieurs millions de portes logiques con�gurables et interconnectables à volonté, ont

fait leur apparition avec les avantages suivants :

• pour le développement de circuits de fortes densités, il est possible de réaliser une simulation en circuit

des propriétés fonctionnelles d'un design. Le concepteur d'un microprocesseur ayant décrit son projet

dans un langage de haut niveau avec un outil de développement intégré transfert l'ensemble de son

design dans des composants logiques programmables de fortes densités et peut ainsi apprécier très

rapidement le résultat de son travail avec une vitesse de traitement proche de la vitesse qu'atteindra

1. Application Speci�c Integrated Circuit
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la puce dé�nitive. En cas d'erreur, il su�t de modi�er le design (du code en général), de recompiler le

projet et, après une étape de placement/routage, de charger de nouveau le projet dans les composants

programmables. De 4 mois pour la fabrication d'une puce mise à jour dans le cas des ASIC Full

Custom, on tombe à quelques heures de retraitement avant un nouveau test avec des composants

logiques recon�gurables haute densité. Lorsque le projet semble dé�nitif, il est alors possible de lancer

la fabrication en série d'une puce gravée, �gée, à partir d'un masque (on reprend le processus �nal de

développement d'un ASIC) ou, comme c'est le cas aujourd'hui, de commander la fabrication de la puce

dédiée au fondeur du composant programmable (technologie HardCopy 2 d'Altera par exemple).

• dans le cas de composants destinés à de petites séries, on ne grave pas de circuit spéci�que à l'issue

de la phase de conception. C'est un composant logique programmable, associé à une mémoire de

con�guration dans le cas des composants programmables reposant sur une technologie volatile, qui

sera fourni à l'utilisateur �nal. Le gain de temps excède alors d'une année le développement d'une puce

ASIC Full Custom et les coûts de production �naux sont comparativement dérisoires.

3 Outils de développement

Les premiers composants logiques programmables (PLD pour Programmable Logic Devices) contenaient

un nombre de portes limité (de l'ordre de 4000) et disposaient grossièrement au plus d'une vingtaine d'entrées

et d'une douzaine de sortie. Il était possible de calculer n'importe quelle équation combinatoire à partir de

ces entrées et de réaliser des systèmes séquentiels simples.

De part leur faible densité, il était aisé de les exploiter totalement avec des environnements de déve-

loppement rustiques basés sur des langages dits de première génération tels que PALASM (AMD), AHDL

(Altera), Abel HDL (Data I/O) ...

Avec l'apparition des premiers CPLD et FPGA, les concepteurs ont rapidement exprimé le besoin d'outils

de plus haut niveau, capable d'o�rir un langage autorisant la synthèse de dispositifs complexes et gourmands

en nombre de portes avec une approche hiérarchique. A l'instar de Verilog HDL son concurrent, le langage

VHDL (Very high speed integrated circuit Hardware Description Language) est apparu comme une solution

intéressante.

Les di�érents fondeurs de composants ont rapidement proposé des outils de développement intégrés

permettant de prendre en charge la conception complète d'un circuit : du design à la programmation �nale

du chip en passant par diverses étapes de simulation.

Ainsi, et puisqu'il autorise des descriptions de modules en langage VHDL, ce cours fera régulièrement

référence au logiciel Quartus II d'Altera.

2. voir http ://www.altera.com/products/devices/



Chapitre 2
Les composants logiques recon�gurables

1 Introduction

Il en existe deux grandes familles :

• les FPGA : Field Programmable Gate Array (Réseaux de champs de portes programmables)

• les CPLD : Complex Programmable Logic Device

Pour faire simple, les FPGA reposent sur une structure matricielle constituée de cellules élémentaires assurant

des calculs combinatoires sur peu d'entrées (moins de 10) avec la possibilité d'en mémoriser le résultat

dans une bascule. Les CPLD, à l'opposé, une architecture distribuée constitué d'énormes blocs de calculs

combinatoires capables de traiter de très nombreuses entrées (parfois toutes les entrées du circuit)

Dans 90% des applications, les FPGA peuvent être utilisés. Le champs d'apptitude des CPLD étant

beaucoup plus restreint et adapté principalement aux systèmes gourmands en calculs combinatoires.

Figure 2.1 � Di�érences de structure des FPGA et CPLD

2 Les CPLDs par l'exemple : la famille XC9500 de Xilinx

2.1 Quelques caractéristiques de la famille XC9500XL

C'est une liste non exhaustive (voir la datasheet Xilinx pour en savoir plus sur www.xilinx.com) :

• Tension d'alimentation de 3.3v pour les XC9500XL.

• Compatible 5v, 3.3v et 2.5v en entrée ; 3.3v et 2.5v en sorties.

• Fréquence maximale de fonctionnement jusqu'à 208 MHz.

• Jusqu'à 6400 portes (équivalent) et 288 macro-cellules.

• Technologie Flash non volatile (10000 cycles).
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2.2 Structure interne des CPLDs XC9500XL

Elle correspond au schéma de la �gure 2.2. Les di�érents éléments sont détaillés dans la suite.

Figure 2.2 � Structure interne des XC9500XL

2.3 Bloc de fonctions (Function Block) et macro-cellules (Macrocell)

Les XC9500 exploitent des blocs fonctionnels capables de traiter un grand nombre d'entrée à la fois pour

des calculs combinatoires et la synthèse de machines séquentielles complexes. C'est en étudiant la macro-

cellule d'un CPLD qu'on prend la mesure de la technologie de ces CPLDs (à comparer avec ce qui sera vu

plus tard pour les FPGAs).

Comme le montre la �gure 2.3, un bloc fonctionnel est un regroupement de 18 macro-cellules.

Figure 2.3 � Function Block

En amont des macro-cellules, le bloc fonctionnel fait apparaître deux premiers éléments :

• le programmable AND Array assurant la complémentation (pour disposer d'une forme complémentée

de chacune des entrées) et l'ampli�cation (bu�ering) des 54 entrées (La structure de ces 18 macro-
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cellules apparaît à la �gure 2.5 et mérite quelques explications) puis le calcul des di�érents produits

qui interviennent dans les équations combinatoires à synthétiser (90 lignes de ET de 108 entrées ; les

54 non complémentées et leurs homologues complémentées).

• les Product Terme Allocators (détail �gure 2.4) dirigent les produits de termes vers les macrocells en

fonction des besoins, accroîssent le potentiel en sommes de termes d'une Macrocell. Dans les faits, ils

apportent 5 produits à chaque macro-cellule et assurent le calcul d'un terme d'extension sous la forme

d'une somme de produits pour la macro-cellule qu'ils alimentent en signaux.

Note : le terme d'extension recevant des signaux provenant des macro-cellules inférieure et supérieure,

et leur fournissant également des signaux, il est ainsi possible de calculer des sommes de produits

faisant intervenir de très nombreux produits. Ce mécanisme de communication entre macro-cellules

permet par ailleurs d'optimiser les calculs arithmétiques mettant en jeu des retenues.

• 18 macro-cellules (macrocells), la macro-cellule constituant l'élément de base des CPLDs.

• PTOE (Product Term Output Enable) est un signal associé à une sortie, autorisant ou non, la sortie

à être véhiculée sur une broche du composant (PTOE pilote en fait une porte 3 états par laquelle la

sortie associée de la macro-cellule transite. Voir la suite).

• Global Set/Reset sont des signaux issus de 2 broches dédiées du composants permettant la remise à 0

ou la mise à 1 asynchrones des bascules de sortie des macro-cellules.

• Global Clocks est une connexion directe d'une broche dédiée du composant vers les entrées d'horloge

des bascules des macro-cellules (optimisation du trajet).

Figure 2.4 � Product Terme Allocator

L'étage de sortie de la macro-cellule (�gure 2.5) fait clairement apparaître :

• La porte OU en entrée pour concrêtiser le calcul de la somme de produits.

• Un OU EXCLUSIF utile dans le cadre du calcul des bits de retenus dans les calculs arithmétiques

binaires.

• Une bascule pour mémoriser le résultat et rendre possible la réalisation de systèmes séquentiels.

• Un multiplexeur de sortie permettant de choisir entre le signal purement combinatoire ou le signal

mémorisé à la sortie de la macro-cellule.

Note : la sortie est dirigée vers le bloc d'entrée/sortie d'une part et vers la matrice d'interconnexion qui

fournit les blocs fonctionnels d'autre part.
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Figure 2.5 � Macrocell

2.4 Blocs d'entrées/sorties

Ils assurent la connexion avec l'extérieur du composant en tentant d'o�rir une compabilité la plus large

possible en termes de signaux. Ainsi, dans le cadre d'une con�guration en sortie, la sortie repose sur un

ampli�cateur 3 états permettant de mettre son signal dans un état de haute impédance suivant une consigne

fournie par PTOE, GTS1, GTS2 ou encore par une information provenant d'une autre macro-cellule que

celle à l'origine du signal de sortie. Lorsque la broche est con�gurée en entrée, le signal lui parvenant passe

par un bu�er d'ampli�cation. Sa structure est présentée �gure 2.6.

Figure 2.6 � I/O Block

Note :

• Les éléments USER PROGRAMMABLE GROUND et BUS HOLD permettent d'assurer des tirages à

la masse ou au VCC si besoin est.

• Pour les sorties, le slew rate (temps de montée) du bu�er de sortie peut être contrôlé.

Les compatibilités de signaux à partir de ces blocs d'entrées/sorties sont les suivantes :

• Bu�er d'entrée (XC9500XL)

� Compatible avec les signaux 5v CMOS, 5v TTL, 3.3v CMOS et 2.5v CMOS

� Référence 3.3v interne pour la stabilité

� Hystérésis de 50mV pour l'immunité au bruit

• Bu�er de sortie (XC9500XL) : la tension de sortie est �xée par la broche dédiée du CPLD : VCCIO
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� 3,3v : compatibilité avec les circuits 3.3v CMOS et 5v TTL

� 2,5v : compatibilité avec les circuits 2.5v CMOS

2.5 Con�guration du circuit : chargement d'un design

Cette con�guration exploite le port JTAG qui est un port de communication série reposant sur un

protocole standard.

Elle peut être e�ectuée à partir d'un PC disposant de l'interface JTAG ou à l'aide d'un programmateur

de composants.

Note importante : l'information de con�guration dans les CPLDs XC9500 (comme dans de nombreux

autres CPLDs) est stockée dans une mémoire de type FLASH si bien qu'elle est conservée en cas de coupure

de l'alimentation.

3 Les FPGAs : illustration avec la famille Cyclone II Altera 1

3.1 Introduction

Les fabricants de FPGAs sont aujourd'hui très nombreux sur le marché. Ils demeurent cependant deux

leaders historiques dont la suprématie est toujours réelle aujourd'hui : Xilinx (série Virtex en haut de la

gamme) et Altera (série Stratix pour le sommet de la production).

Les FPGAs ont une structure matricielle dont les éléments de base permettent des traitements logiques

combinatoires et/ou séquentiels opérant sur peu de données binaires. Typiquement, l'élément de base, appelé

CLB pour Complex Logic Block chez Xilinx ou LE pour Logic Element chez Altera, permet de traiter des

équations à 4 entrées auxquelles peuvent s'ajouter des signaux de calculs en chaîne tels que le signal de retenu

apparaîssant lors d'une addition binaire. En limitant le nombre d'entrées traitées dans un CLB ou LE, les

concepteurs ont visé une bonne optimisation du taux d'utilisation des portes présentes dans le composant lors

des calculs combinatoires (à l'opposé des CPLD conçus pour des calculs mettant en jeu beaucoup d'entrées).

Parce qu'ils disposent d'un programme de dotation universitaire permettant d'être équipé totalement

gratuitement, il y a quelques années, j'avais fait le choix de travailler avec des FPGA Xilinx. La gamme

utilisée jusqu'ici en travaux pratiques, à savoir la famille XC4000XL, n'existant plus au catalogue Xilinx et

n'étant plus gérée par les dernières versions du logiciel ISE Foundation Xilinx dans sa version Web gratuite,

j'ai choisi d'utiliser la technologie Altera pour la promotion 2008-2009. De fait, les 400 CLB du XC4010XL

que nous utilisions par le passé ont été remplacés par les 35000 LE du Cyclone II EP2C35F672C6 qui est un

FPGA mature de moyenne densité au sein de la gamme Altera 2008.

3.2 Caractéristiques principales de la famille Cyclone II

Les Cyclone II sont venus compléter la gamme Cyclone �n 2004.

Leurs principales caractéristiques sont :

• Une gravure en 90 nm. C'est un paramètre important car plus la gravure est �ne et plus l'élément de

base qu'est le transistor est petit et voit sa consommation et donc ses dégagements en chaleur diminués.

Note : graver plus �n permet également de placer davantage de portes dans le FPGA à surfaces égales.

• Une architecture haute densité avec entre 4608 et 68416 LE (Eléments logiques).

• Ils intègrent jusqu'à 1.1 Mbits de RAM (M4K Blocks) avec :

� une largeur de bus de données con�gurable (x1, x2, x4, x8, x16, x32 et x36),

� un véritable mode double accès,

� une vitesse de fonctionnement pouvant atteindre 260 MHz.

• Ils comprennent une zone où sont gravés dès la fabrication jusqu'à 150 Multipliers 18x18 (Embeded

Multipliers).

1. Consulter le Cyclone II Device Handbook volume 1 pour plus d'informations
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• Et ils possèdent des blocs d'entrées/sorties avancées (IOE : Input/Output Element) avec :

� des entrées/sorties di�érentielles (LVDS, LVPECL . . . ),

� des entrées/sorties simples (3.3v, 2.5v, 1.8v et 1.5v LVCMOS, 3.3v, 2.5v et 1.8v LVTTL . . . ),

� une compatibilité avec les signaux PCI et PCI Express.

• Il y a une circuiterie dédiée aux horloges (PLL) :

� 2 à 4 PLL pour multiplier ou diviser les fréquences d'horloge entrantes, les retarder ...

� jusqu'à 16 lignes d'horloges en interne

� une gestion jusqu'à la fréquence maximale de 402.5 MHz

• En�n, un dispositif de con�guration avec :

� un mode rapide pour une con�guration en moins de 100 ms

� mode série ou JTAG possible avec des mémoires de con�guration série de bas coût

Comme de nombreuses autres familles Altera, de nombreux modules de propriétés intellectuelles sont dispo-

nibles (processeur, DSP, interfaces, communication . . . ) .

Par ailleurs, le logiciel SOPC Builder permet de construire un système complet sur une puce Cyclone

II en quelques clics, intégrant processeurs, interfaces diverses, mémoires de programmes, de données, des

contrôleurs d'écran ...

3.3 Vu de l'intérieur

Les di�érents FPGA du marché (Altera, Xilinx, Atmel ...) ont des structures internes assez semblables.

Il n'est pas limitatif d'un point de vue conceptuel de ne s'intéresser qu'à la famille Cyclone II d'Altera.

3.3.1 Vision interne globale

Elle est représentée �gure 2.7.

Figure 2.7 � Structure interne d'un Cyclone II

Les Logic Array sont constitués de plusieurs blocs de réseaux logiques (LAB : Logic Array Block). C'est à

l'intérieur de ces blocs que les systèmes combinatoires et séquentiels réalisés par le concepteur se matérialisent

au niveau de éléments logiques (LE : Logic Element)
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3.3.2 Elément logique (LE)

C'est le plus petit élément de logique dans le Cyclone II. Sa structure apparaît sur la �gure 2.8.

Figure 2.8 � Structure d'un Logic Element

Cette cellule recon�gurable (on parle davantage de recon�guration que de programmation dans le cas

d'un composant logique) contient divers éléments :

• une LUT (Look up table) à 4 entrées permettant le calcul de n'importe quelle fonction de 4 entrées,

• 1 registre de sortie programmable,

• Parce que les Logic Element sont regroupés par 16 dans des Logic Array Blocks, ils disposent de plus :

� d'une entrée spéci�que de retenue dédiée pour les calculs chaînées (Carry Chain) provenant du LE

précédent dans le même LAB,

� 1 signal de Carry de sortie destiné au LE suivant dans le même LAB.

Note :

La LUT du LE peut être utilisée suivant deux modes :

• Combinatoire : on dispose alors d'une LUT à 4 entrées.

• Arithmétique : la LUT se scinde en 2 LUT à 3 entrées, l'une fournissant le signal de sortie qui pourra

être mémorisé dans le registre de sortie ; l'autre assurant de calcul d'une retenue, la Carry de sortie.

3.3.3 Les blocs de réseaux logiques (LAB)

Un bloc de réseaux logiques contient :

• 16 Eléments Logiques (LE).

• des signaux dédiés pour optimiser les calculs entre LE (signal de carry par exemple).

• Un réseau d'interconnexion local pour la communication entre LE du même LAB (voir �gure 2.9).

• Un accès direct aux éléments adjacents du LAB dans la structure du FPGA (voir �gure 2.10) tels que :

� un autre LAB,

� un bloc mémoire pour les LAB adjacents aux zones mémoires,

� un signal d'horloge d'une PLL,

� un multiplier,
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� un IOE (Elément d'entrée/sortie),

� un accès aux réseaux d'interconnexions lignes/colonnes pour atteindre n'importe quel point du com-

posant.

Figure 2.9 � Connexions chaînées entre LEs dans un LAB

Figure 2.10 � Connexion directe au niveau d'un LAB

3.3.4 Interconnexions longues distances

Les deux sections précédentes ont fait apparaître deux types d'interconnexions : entre LEs d'une part et

entre éléments de natures variées adjacents aux LABs d'autre part (mémoire, autre LAB, IOE, multiplier).

Compte tenu de la structure très étendue du circuit et du nombre de LABs importants (jusqu'à 4000), 2

autres voies d'interconnexions sont possibles et visent à permettre des liaisons rapides entre LABs éloignés

(transit en colonne de 4 en 4 LABs ou 24 en 24 LABs ; en ligne de 4 en 4 LABs ou de 16 en 16).
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Figure 2.11 � R4 interconnect

Figure 2.12 � C4 interconnect

3.3.5 Gestion des signaux d'horloge

C'est un point crucial à l'intérieur des FPGAs (et même à l'intérieur des circuits numériques rapides

en général). En e�et, pour que les phénomènes dans un circuit numérique restent parfaitement synchrones,

la structure interne du composant doit être rigoureusement pensée en terme de temps de propagation des

signaux d'horloge.

Pour atteindre les objectifs en la matière, la famille Cyclone II exploite di�érentes techniques :

• Les signaux d'horloge ne transitent pas par le réseau d'interconnexions des autres signaux mais dis-

posent d'un réseau dit �d'horloges globales� pour assurer des liaisons à la durée optimisée (ce réseau

peut compter jusqu'à 16 horloges di�érentes dans la famille Cyclone II).
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• Dans de nombreuses situations, l'existence de signaux d'horloge de fréquence élevée à l'extérieur du

composant peut présenter des di�cultés de conception (au niveau du circuit imprimé particulièrement).

Dans d'autres cas, le concepteur peut avoir besoin de plusieurs fréquences d'horloge di�érentes, décalées

dans le temps, multiples les unes des autres ... Pour ces di�érentes raisons, la plupart des FPGAs

d'aujourd'hui intègrent des boucles à verrouillage de phase (PLL : Phase Locked Loop ; voir programme

d'électronique de seconde année). Ces PLLs (4 au maximum dans la famille Cyclone II) permettent

donc de fabriquer des horloges répondant aux di�érents besoins du concepteur sur la base d'une horloge

externe de fréquence modérée.

Figure 2.13 � Global Network Clock - PLL

3.3.6 Bloc d'entrée/sortie (IOE : Input Output Element)

Avec l'accroissement constant du nombre de standards d'entrées/sorties en électronique numérique, la

conception d'un FPGA a progressivement nécessité de faire apparaître des blocs dédiés capables d'interfa-

çages s'adaptant à une grande diversité de situation.

La frange supérieure des composants de la famille Cyclone II dispose donc de nombreux blocs d'entrées/-

sorties (I/O Banks) répartis à la périphérie du composant comme le montre la �gure 2.14.
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Figure 2.14 � Répartition des IOE (Input Output Elements) dans les I/O Banks - Signaux pris en charge

En bref, la famille Cyclone II peut s'interfacer avec des circuits logiques :

1. LVTTL et LVCMOS : Interfaçage avec des circuits logiques d'usage général, fonctionnant à des fré-

quences en deça de 100MHz.

• SSTL : Standard mis en place pour la mémoire SDRAM DDR (Double Data Rate).

• HSTL : Signaux des mémoires QDR 2 SRAM (Quad Data Rate).

• LVDS (Low Voltage Di�erential Signaling) : Signaux di�érentiels (ils garantissent une plus grande

immunité au bruit) pour des communications à fort débit (jusqu'à 805 Mbps) et faible EMI (émissions

électromagnétiques)

• LVPECL (Low Voltage Positive Emitter Coupled Logic) : Signaux di�érentiels à haute immunité au

bruit utilisés en video, télécom, distribution d'horloge.

• PCI et PCI Express Bus locaux des PC utilisés pour la connexion de carte d'extension (Video . . . ).

3.3.7 Fonctionnalités de traitement du signal : multipliers embarqués

Pour les applications gourmandes en traitement du signal, la famille Cyclone II intègre de nombreux

multipliers directement gravés sur la puce a�n de ne pas avoir à grèver le potentiel de LE (la réalisation d'un

multiplier est exigeante en nombre de portes).

Note : la télévision numérique, le son et l'image en général, sont des cibles privilègiées où les traitements

nécessitent des multiplications massives à des cadences assez importantes. Cela justi�e l'existence de telles

structures dans les FPGA.

A l'intérieur des FPGAs Cyclone II, les multipliers opérent sur des mots de 18 bits avec un résultat sur

36 bits et sont regroupés dans des blocks placés en colonnes dans le FPGA qui peut comporter jusqu'à trois

colonnes de ces multipliers (cf. �gure 2.15).

2. Quad Data Rate : mémoire à l'accès en écriture sur fonts montants et descendants de l'horloge d'écriture et accessible en
lecture sur les fronts montants et descendants d'une horloge de lecture.
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Note : alors qu'un processeur classique pourra e�ectuer jusqu'à 8 multiplications par cycle d'horloge, il

est possible dans un temps semblable d'en réaliser de 4 à 20 fois plus dans un FPGA.

Figure 2.15 � Structure en colonne des multipliers au milieu de LABs

Figure 2.16 � Structure interne d'un multiplier en mode 18 bits

Note : pour être plus précis, il existe deux modes de con�gurations des multipliers :

• un premier mode où les multipliers fonctionnent en 18 bits (cf. �gure 2.16).

• un second mode permettant d'obtenir deux multipliers 9 bits x 9 bits en lieu et place d'un modèle 18

bits x 18 bits.

3.3.8 Dispositif de con�guration

Contrairement au CPLD vu précédemment, les FPGAs Cyclone II conservent leur con�guration en interne

avec une mémoire vive statique (SRAM). Par conséquent, cette con�guration disparaît à chaque coupure de

la tension d'alimentation.

Durant les phases de tests ainsi qu'une fois le design validée, il est nécessaire de pouvoir e�ectuer la

con�guration du FPGA pour transférer le design conçu avec le logiciel de développement Quartus II.
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Dans le cas de la famille Cyclone II, Altera a mis en place 3 modes de con�guration :

• deux sont à réserver aux phases de développement :

� le mode Passive Serial Con�guration rend le FPGA passif (esclave) et permet à un élément actif (le

maître) de con�gurer les di�érents éléments internes du composant.

� le second mode exploite le bus JTAG qui, outre la possibilité de con�gurer le composant, apporte

au concepteur de nombreux autres avantages au cours des phases de développement. En particulier,

il permet aussi d'observer les signaux internes du FPGA durant son fonctionnement.

Note : le contrôle total du transfert de l'information de con�guration nécessite un élément actif sophis-

tiqué. C'est ce qui explique la présence d'un troisième mode dont l'exploitation est beaucoup moins

coûteuse.

• un mode pour la con�guration du FPGA au design achevé :

� c'est le mode Active Serial Con�guration. Le FPGA dispose d'une logique de commande interne lui

permettant de contrôler le chargement de sa con�guration interne à partir d'une mémoire passive

extérieure peu coûteuse à fabriquer.

Il est important de noter qu'il est possible de con�gurer plusieurs FPGAs à partir d'une seule mémoire de

con�guration. De la même façon, bus JTAG et con�guration passive (voir �gure 2.17) permettent de prendre

le contrôle de plusieurs FPGAs reliés ensemble et disposés sur un même PCB.

Figure 2.17 � Con�guration passive de plusieurs Cyclone II chaînés
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Chapitre 3
La plateforme de développement Quartus II d'Altera

En bref... Même s'il existe des environnements multi-fondeurs (Active-HDL, Cadence ...), les outils de

fabricants tels que ceux de Xilinx ou Altera constituent une excellente base de travail. Ce chapitre propose

une illustration succinte de l'outil de conception Quartus II d'Altera et commence donc par une présentation

du cycle de développement d'un composant logique recon�gurable.

1 Design Flow

Pour mener à bien un projet dans sa globalité, la plateforme Quartus II intègre de très nombreux outils

et permet de prendre en charge le cycle (cf. �gure ) de développement complet d'un PLD (CPLD ou FPGA)

où se succèdent les étapes suivantes :

• Saisie du projet sous di�érentes formes :

� Saisie de schémas : elle utilise des blocs logiques de base (portes logiques, modules arithmétiques,

éléments d'interfaçage, blocs dé�nis par l'utilisateur en langage VHDL ou dans un autre mode de

représentation, entrées/sorties...).

� Représentation par une machine d'état.

� Code écrit en VHDL (dans le cadre du cours ENSL1) mais aussi en Verilog HDL, AHDL ...

• Simulation fonctionnelle (RTL 1) : elle permet de véri�er la validité de la conception à un niveau

fonctionnel sans faire intervenir les temps de propagation dans le circuit.

• Synthèse : c'est l'étape qui minimise et optimise la netliste RTL. A l'issue de la synthèse, la description

du projet quitte le monde RTL et repose sur l'emploi de primitives propres à la famille de composants

ciblée.

• Placement/routage :

� Quartus utilise le résultat de la synthèse, place les primitives dans le circuit et assure les intercon-

nections entre les blocs logiques.

� C'est aussi à cet instant du design �ow que les contraintes fournies par l'utilisateur sont prises en

comptes :

∗ orientation des signaux d'entrée et de sortie vers des broches choisies du composant (outil Pins

Assigment),

∗ choix de l'endroit où seront implémentés les di�érentes blocs fonctionnels du projet (outil Chip

Planner).

• Analyse temporelle : elle permet de véri�er que le cahier des charges en matière de fréquence de

fonctionnement peut être rempli par le design réalisé.

• Simulation temporelle : on y véri�e le fonctionnement de la puce �nale en tenant compte des temps

propagations des di�érents signaux à l'intérieur du composant. C'est l'étape ultime de contrôle.

1. Register Transfer Level : représentation niveau bascule et équation combinatoire d'un code VHDL synthétisable.
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• Programmation du composant par téléchargement via le PC avec possibilité d'e�ectuer des tests di-

rectement en situation et de visualiser les signaux internes avec l'outil Signal Tap II Debugger.

Figure 3.1 � Quartus II Design Flow (source : Tutorial Quartus)

2 Philosophie du développement : un exemple de design

2.1 Quelques consignes

Un petit dessin vaut mieux qu'un long discours. Lors de la conception d'un projet nécessitant la mise

en oeuvre de di�érentes fonctions, on représentera toujours le projet par un schéma illustrant la structure

fonctionnelle du projet. Ce schéma mettra en évidence les relations entre les di�érents blocs fonctionnels du

projet, leurs interconnections, les connections avec l'extérieur ; chacuns des blocs fonctionnels pouvant être

eux mêmes décrits par des schémas et, plus fréquemment dans notre cas, par du code VHDL, une machine

d'état ... bref, tous les modes de saisie possibles.

Conséquence : certaines spéci�cités du VHDL (techniques de liaisons ou de générations de blocs par le

VHDL) n'ont pas besoin d'être connues. L'outils de CAO en génère le code lui même. L'objectif de ce cours se

limitera donc à l'apprentissage du VHDL pour la description de bloc fonctionnel s'appuyant sur l'utilisation

d'un environnement tel que Quartus disposant d'une saisie de schéma hiérarchique. Cette approche, aussi

minimaliste soit elle aux yeux d'un spécialiste, permet néanmoins d'aborder le VHDL en douceur. Les limites

de ce cours sont claires : la réalisation d'un décodeur MPEG2 vidéo n'est pas un objectif !

Nous observerons les règles suivantes :

• La description en langage VHDL d'un bloc fonctionnel doit être la plus simple possible.

• Si une fonction paraissant trop complexe peut être décrite par un schéma hiérarchique utilisant des

éléments plus faciles à implémenter, alors il en sera fait ainsi a�n de facilité la conception des vecteurs
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de test et de rendre ainsi le test plus exhaustif.

• L'utilisation de portes logiques résultant de mises en équations hasardeuses et au schéma peu lisible

doit être proscrite : � Pensez et décrivez vos projets en terme fonctionnel ! �

2.2 Un premier projet : comptage et a�chage des secondes de 0 à 9

2.2.1 Approche fonctionnelle

Cahier des charges : on souhaite réaliser un compteur de seconde élémentaire ne comportant qu'un seul

chi�re est dont le résultat doit être a�ché. On dispose pour cela d'un signal d'horloge précis de 50 MHz et

d'un a�cheur 7 segments.

Notes :

• Vu la simplicité du cahier des charges, il ne serait pas choquant de décrire l'ensemble du projet en un

seul �chier VHDL où les di�érents aspects fonctionnels seraient de toute façon abordés séparément en

di�érents endroits du code. Il y a donc également une raison plus pédagogique de proposer ce découpage

fonctionnel sous la forme d'un schéma hiérarchique.

• On utilise généralement les FPGA pour réaliser des tâches rapides. Un comptage à l'écehelle d'une

seconde se réalise davantage avec un microcontrôleur.

Méthode de résolution : il serait tout à fait possible d'écrire un programme VHDL unique prenant en entrée le

signal d'horloge et fournissant directement 7 informations représentatives de l'état des segments de l'a�cheur

pour retranscrire visuellement le nombre de secondes. Néanmoins, le programme obtenu serait très spéci�que

et ne laisserait pas apparaître les concepts de développement de façon visible. Une seconde approche consiste

à voir le problème par ses spéci�cations fonctionnelles a�n d'en déduire une forme de solution résultant de

l'association de blocs fonctionnels assez classiques et à l'implémentation simple.

Des pistes de résolutions :

• L'objectif étant de compter des évènements chaque seconde, il faut donc constituer un signal d'horloge

de 1 Hz. L'horloge disponible sur la carte de développement DE2 est de 50 MHz et il apparaît donc

judicieux de réaliser un premier bloc fonctionnel de division de fréquence avec un rapport de 50 000

0000 caractérisable comme suit :

Fonction : d i v i s e u r de f r équence ( c ' e s t une forme de compteur ) .

Entrées :

clk_50MHz : l e s i g n a l d ' hor loge à 50 MHz de l a ca r t e DE2.

r e s e t : un s i g n a l d ' i n i t i a l i s a t i o n .

S o r t i e :

clk_1s : l e s i g n a l de 1 Hz qui s e ra u t i l i s é pour attaquer l e

compteur de secondes .

Codage : VHDL.

• A partir de ce signal de 1 Hz, il reste donc à compter de 0 à 9 et à a�cher le chi�re compté sur

un a�cheur 7 segments. Deux éléments fonctionnels se détachent naturellement de la description du

travail restant.

Fonction : compteur BCD ( comptage cy c l i qu e de 0 à 9 ) .

Entrées :

clk_1s : s i g n a l d ' hor l oge d ' en t r é e du compteur BCD.

r e s e t : s i g n a l de remise à 0 asynchrone du compteur pour l e s

phases d ' i n i t i a l i s a t i o n .

S o r t i e :

bcd [ 3 . . 0 ] : vec teur 4 b i t s ( pour a u t o r i s e r un codage d ' e n t i e r s de 0 à 9 ) .

Codage : VHDL (on pour ra i t u t i l i s e r l e générateur de MegaFonctions

i n t é g r é à l a s a i s i e de schéma de Quartus ) .
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Fonction : décodeur BCD vers 7 segments

( f o u r n i t 7 s ignaux a , b , c , d , e , f , g pour attaquer

l e s 7 segments de l ' a f f i c h e u r et f a i r e appa ra î t r e

l e c h i f f r e codé par BCD sur 4 b i t s ) .

Entrée :

bcd [ 3 . . 0 ] : vec teur 4 b i t s r ep r é s en tant l ' e n t i e r à a f f i c h e r .

S o r t i e :

a , b , c , d , e , f , g : l e s 7 s ignaux correspondants aux 7 segments

de l ' a f f i c h e u r .

Codage : VHDL (même s i l e s b i b l i o t h èqu e s Altera basées sur

MAX PLUS 2 , l ' ancê t r e de Quartus , i n t è g r en t ce genre de symbôles ) .

Remarque : il existe de nombreux outils (Quartus en intègre) permettant de générer des éléments rela-

tivement standards (pour des fonctions simples telles que des additionneurs, compteurs ...) avec une liberté

de paramètrage autorisant une juste adaptation aux besoins de chacun. Au delà des fonctions simples, de

nombreuses sociétés proposent des modules de propriétés intellectuelles (IP pour Intellectual Property) pour

des fonctions beaucoup plus sophistiquées telles que des coeurs de microprocesseur (les IBM Power PC et

Strong ARM sont fréquents), des décodeurs audio ou video, des interfaces Ethernet ...

2.2.2 Réalisation sous Quartus II

La réalisation sous Quartus amène donc à l'écriture de 3 sources VHDL et d'un schéma hiérarchique. Ce

dernier est présenté sur la �gure .

Remarque : la réalisation complète de ce projet fera l'objet d'une séance de travaux pratiques.

Figure 3.2 � Schéma hiérarchique du compteur de secondes

3 Utilisation de Quartus II sur un exemple simple

3.1 Introduction

A�n de se concentrer sur les éléments essentiels de la création d'un projet sous Quartus II, le sujet de

démonstration est une simple porte ET à deux entrées. Pour que l'approche hiérarchique à partir d'un schéma

fonctionnel soit abordé, cet exemple n'utilise pas une porte existante à l'intérieur de l'éditeur de schéma mais

un symbôle représentant un ET à deux entrées et dont le comportement va être décrit dans un programme

écrit en VHDL.

3.2 Création du projet

Quartus II démarré, on crée un nouveau projet : File -> New Project...
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La première boite de dialogue permet de �xer le nom du projet et son lieu de stockage (voir �gure 3.3).

Figure 3.3 � Création de projet sous Quartus II

Dans la seconde, il est possible d'ajouter des �chiers déjà existants au projet. Ne rien ajouter et cliquer

sur le bouton Suivant.

La troisième fenêtre de dialogue permet de choisir le FPGA ou CPLD ciblé. Le composant utilisé dans

l'ensemble de ce cours est le CYCLONE II EP2C35F672C6 (famille : CYCLONE II ; nombre d'éléments

logiques : 35k ; boitier : F pour FGA ; nombre de broches : 672 ; grade de vitesse : 6).

Une fois choisi, on en termine avec l'assistant de création de projet en cliquant sur Finish.

L'environnement de Quartus II (�gure 3.4) : il se découpe en 4 parties. 3 sont visibles au début du projet.

Une fenêtre Project Navigator qui contient toutes les informations relatives au projet dont les détails sur la

hiérarchie du projet, les �chiers le constituant, les di�érentes unités dé�nies (entités, architecture, schémas,

machines d'états ...). La fenêtre Tasks présente les di�érentes tâches du Design Flow avec la possibilités

d'accéder à l'ensemble des processus de traitement de Quartus, les comptes rendus associés. Pour �nir, la

fenêtre Messages avec ses onglets de �ltrage multiples permet d'être informé en continu des informations,

averstissements et erreurs apparaissant lors de l'exécution des diverses tâches.

Figure 3.4 � Environnement de développement de Quartus II
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Avant d'aborder la suite du projet, quelques remarques et rappels s'imposent :

• Dès lors que le projet possède plusieurs blocs fonctionnels, son design repose sur une hiérarchie avec un

schéma à l'apparence la plus fonctionnelle possible en son sommet (top hierarchy). Cela signi�e qu'on

évitera de placer des structures nébuleuses à base de portes logiques élémentaires dans ce schéma du

sommet hiérarchique.

• Lors du design sur Quartus II d'un projet hiérarchique, le concepteur commence par décrire les blocs

fonctionnels de plus bas niveau en premier (en les testant séparément). Le schéma donnant la structure

fonctionnelle situé au sommet de la hiérarchie est saisie en dernier. Il faut avoir à l'esprit que ce schéma

ne peut de toutes façons être dessiné qu'à partir du moment où le concepteur dispose des symbôles

adéquats, dont l'existence est subordonnée à la réalisation préalable des di�érents éléments fonctionnels

du projet.

3.3 Premier source VHDL

Le cycle de développement obéïssant à une philosophie montante, on commence donc par la conception

des di�érents blocs VHDL (puisque le choix est fait de décrire ces blocs en VHDL dans le cadre de ce cours).

Dans le cadre de ce premier exemple, le choix est fait de se limiter à un projet ne contenant qu'un seul source

VHDL décrivrant le comportement d'une porte ET.

Pour ajouter un nouveau source VHDL : File -> New... et on choisit un source de type VHDL (il est

intéressant de remarquer l'étendue des possibilités en matière de source).

Les détails de l'écriture du code à proprement parler seront vus dans la suite du cours.

Taper le code suivant et le sauver (File -> Save As... en lui donnant le nom porte_et.vhd).
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−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
l i b r a r y i e e e ; −− Chargement de l a b ib l i o th èque IEEE

−− qui e s t i nd i s p en s ab l e en VHDL

use i e e e . std_logic_1164 . a l l ; −− Ut i l i s a t i o n du paquetage

−− std_logic_1164 en t o t a l i t é

use i e e e . numeric_std . a l l ; −− Ut i l i s a t i o n t o t a l e du paquetage

−− numeric_std

−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−− Desc r ip t i on exte rne de l a porte_et2

−− On ind ique l a l i s t e des en t r é e s et l a l i s t e des s o r t i e s

−− Le mot c l é en t i t y d é c l a r e l e début de l a d e s c r i p t i o n exte rne

−− dont l e nom e s t porte_et2

−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
en t i t y porte_et2 i s port (

−− Input por t s

entree_a : in s td_log i c ; −− au nom de l ' en t r é e succède : pu i s

−− l e sens in pour ent r é e et son type

−− s td_log i c (un type b i n a i r e amé l io ré )

entree_b : in s td_log i c ;

−− Output por t s

s o r t i e : out s td_log i c −− bien entendu , on u t i l i s e out pour

−− l e s s o r t i e s

) ;

end porte_et2 ;

−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
−− L ' a r c h i t e c t u r e apporte une d e s c r i p t i o n i n t e rn e comportementale

−− du bloc f o n c t i o nn e l d é c l a r é dans l ' e n t i t é .

−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
a r c h i t e c t u r e comportement_porte_et2 o f porte_et2 i s

begin

−− Dans c e t t e exemple , on s a i s i e simplement une équat ion l og i que .

s o r t i e <= entree_a and entree_b ;

end comportement_porte_et2 ;

Remarque : l'étudiant confronté à l'apprentissage de nombreux langages peut rapidement se trouver

submerger par la mémorisation précise requise par les di�érentes syntaxes auquelles il se heurte. L'éditeur de

Quartus propose donc un outil permettant d'accéder à des modèles pour les diverses instructions du langages

VHDL (idem pour Verilog) ; modèles qu'il est possible d'inclure d'un simple clic dans le code source en cours

d'édition. Cet outil (Template) est accessible via le menu Edit -> Insert Template... ou via l'outil dans

la palette d'outils de l'éditeur.

3.4 Véri�cation de la syntaxe du code

Outre un repérage des mots clés par des couleurs di�érentes, l'éditeur de code VHDL Quartus propose un

outil de contrôle d'erreur très utile pour limiter la présence de coquilles et d'erreur d'inattention syntaxique

dans le code.

Il est donc conseillé de l'utiliser (Menu Processing -> Analyse current �le ou l'outil dans la palette

d'outils de l'éditeur).

3.5 Création d'un stimulus de simulation

Quand le code VHDL est correct en matière de syntaxe, il est ensuite nécessaire de le tester en lui

appliquant di�érents vecteurs de test. Les systèmes de développement proposent en général deux solutions
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pour réaliser ce test :

• L'éditeur graphique de vecteurs de test (Vector Waveform Editor) comme le propose Quartus II. C'est

simple d'utilisation, visuel mais ne permet pas les tests les plus exhaustifs qui soient.

• Le banc de tests VHDL (réciproquement Verilog pour les concepteurs qui décrivent leurs blocs fonc-

tionnels avec ce langage). Moins facile d'accès au premier abord, il o�re une souplesse incomparable

par rapport à l'éditeur graphique et permet des tests beaucoup plus complets. L'outil de simulation

intégré à Quartus ne gère pas ces Test benchs mais permet cependant d'exporter un test graphique

sous la forme d'un test bench VHDL qu'il su�t ensuite de retravailler. Pour �nir, il su�t de le fournir

à un outil de simulation externe (EDA Simulator). Dans notre cas, ModelSim Altera sera le simulateur

tièrce partie mis en oeuvre pour les simulations à partir de vecteurs de tests fournis avec un �chier

VHDL.

Pour créer un �chier de test graphique, atteindre le menu File -> New... et choisir Vector Waveform File.

Dans la foulée, utiliser la commande Save As... pour enregistrer le �chier de test sous le nom test_porte_et2.

A�n de rendre les signaux d'entrées et de sorties accessibles à l'édition dans l'éditeur graphique, il faut

réaliser une compilation de Design : menu Processing -> Start Compilation.

Ajouter des signaux d'entrée :

• Pour créer des stimuli sur les entrées, il faut ajouter les signaux d'entrées dans la colonne Name par

un double clic dans cette même colonne (ou la commande Insert -> Insert Node or Bus... du menu

Edit). Poursuivre par un clic sur le bouton Node Finder... de la boite de dialogue qui apparaît. Dans

le second dialogue, sélectionner Pins :all dans la boite de liste Filter et lancer l'opération de �ltrage

par un clic sur le bouton List.

• Ajouter les signaux entree_a et entree_b dans la liste des signaux sélectionnés (Selected Nodes) en

utilisant le bouton > . Puis valider par OK deux fois.

Donner un stimulus à un signal :

• Sélectionner le signal entree_a dans la colonne Name.

• Création d'un signal de type horloge pour le stimulus de entree_a : Menu Edit -> Value -> Clock...

(ou cliquer sur l'outil de création d'horloge ). On remplit le dialogue d'horloge pour créer une

horloge de 100 ns de période (Period : 100 ns).

Remarque : pour changer la durée de la simulation, utliser la commande du menu Edit -> End Time... .

Reprendre la même manipulation pour la seconde entrée avec une période de 200 ns.

Terminer en sauvant le �chier de test graphique.

3.6 Simulation du projet

Il est maintenant temps de simuler le projet. Pour cela, il convient préalablement de dé�nir les paramètres

de simulation en accédant à la boite de dialogue correspondante (menu Assigments -> Settings puis Category

Simulator Settings ou également par la fenêtre de tâches, section Verify Design -> Simulate Design ->

Quartus II simulator -> Edit settings).

• Choisir une simulation fonctionnelle (Functional Simulation) pour le mode de simulation (Simulation

mode).

• Ajouter le �chier test_porte_et2.vwf pour les paramètres d'entrées de la simulation (Simulation input).

• Valider par OK.

Dans la fenêtre des tâches, lancer la simulation par un double-clic sur Quartus II Simulator (Functional).

On obtient le résultat de la �gure 3.5.
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Figure 3.5 � Simulation fonctionnelle de la porte_et2

Pour �nir, reprendre les étapes précédentes avec une simulation temporelle (en choisissant Timing pour

le mode de simulation). Les résultats obtenus doivent être identiques à ceux de la �gure 3.6.

Figure 3.6 � Simulation temporelle de la porte_et2

Remarque : on peut constater que le signal de sortie est di�érent de ce qui avait été obtenu dans le cadre

de la simulation fonctionnelle. Deux phénomènes se manifestent : d'une part, un retard du signal de sortie

(bien visible lorsque les deux entrées sont à '1') et d'autre part un comportement parasite repérable par la

présence d'impulsion parasite (glitch) au moment où les signaux d'entrées se �croisent�.




